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Avant-propos 
 

 

Ce manuel de cours / TP, intitulé « Informatique 3 » est une matière méthodologique qui est étudiée 

par les étudiants en 2ème année licence, semestre 3, troc commun sciences et technologies de toutes 

les spécialités. Le programme de ce cours/TP est conçu pour apprendre aux étudiants une 

compréhension fondamentale sur la programmation et le calcule numérique par Matlab. 

 

Bien que l’environnement Matlab signifie la contraction de MATrix LABoratory en Anglais i.e. 

laboratoire des matrices. MATLAB est un langage de programmation informatique puissant, dont 

vous pouvez l'utiliser comme une calculatrice, et c'est une bonne technique pour essayer des idées 

que vous pourriez utiliser dans votre programme. Toutefois, lorsque vous avez dépassé l'étape de 

l'expérimentation, vous comptez généralement sur MATLAB pour créer un programme qui vous 

aide à effectuer des tâches : Régulièrement, Facile et Rapide. Ces trois caractéristiques ne vous 

disent pas tout ce que MATLAB peut faire, mais elles vous fournissent des idées que vous pouvez 

poursuivre et utiliser à votre avantage. 

 

Les disciplines des Sciences, de la Technologie, de l'Ingénierie et des Mathématiques (STIM) 

mettent actuellement l'accent sur les sujets de simulation des modèles mathématiques avent 

l’expérimentation. L'innovation de tout le tri requiert ces disciplines, comme le font de nombreux 

métiers pratiques. MATLAB dispose d'une riche et grande boîte à outils pour STIM qui comprend 

: Statistiques, Simulation, Traitement d'images, Traitement symbolique et l’Analyse numérique. 

 

Méthode de rédaction 

Les suggestions pour l'amélioration du cours seront très appréciées. Bien que toutes les précautions 

aient été prises pour éliminer les erreurs, il est très difficile de prétendre à la perfection. Je serai 

très reconnaissant aux enseignants et étudiants et aux membres d’utilisateurs de ce cours s'ils 

signalent toute erreur qui aurait pu s'y glisser.  

 

Afin de simplifier l’apprentissage aux étudiants ; chaque fiche de cours/TP contient quatre partie : 

1. L’objectif de TP ; 

Couvre le but de TP et les principales idées enseignée. 

2. Partie 01 : Partie théorique (l’interface de Matlab) ; 

Les définitions des commandes et instructions utilisées lors de la séance. 

3. Partie 02 : Partie Simulation (MATLAB – SIMULINK) ; 

Des exercices résolus incluant des figures d’apprentissage.  

4. Partie 03 : Partie expérimentale (MATLAB – SIMULINK). 

Des exercices pour s’adapter avec les problèmes de programmation et l’application des 

notions visée sur les parties 1 et 2. 

 



Organisation des fiches TP 

Conformément au canevas officiel, ce cours est divisé en huit fiches : 

 

TP N° L’intitulé Durée 

TP 1 Présentation d’un environnement de programmation scientifique (MATLAB)  1 semaine 

TP 2 Lecture, affichage et sauvegarde des données  2 semaines 

TP 3 Fichiers script et Types de données et de variables 2 semaines 

TP 4 Vecteurs et matrices 2 semaines 

TP 5 Instructions de contrôle (Boucles for et While, Instructions if et switch) 2 semaines 

TP 6 Fichiers de fonction  2 semaines 

TP 7 Graphisme (Gestion des fenêtres graphiques, plot ) 2 semaines 

TP 8 Utilisation de toolbox  2 semaines 
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TP 01 : Présentation d’un environnement de programmation scientifique (MATLAB) 

 

L’objectif de TP : 

Ce TP01 et TP02 a pour but de vous familiariser avec l’interface et les bases de 

l’environnement MATLAB afin d’utiliser quelques fonctions de base pour la lecture, 

l’affichage et le sauvegarde des données. 

 

 

Partie 01 : Partie théorique (l’interface de Matlab) 

Nous allons nous familiariser avec l’interface de Matlab. Selon la version utilisée, l’interface 

peut changer légèrement mais les points centraux resteront identiques. 

 

Command Windows 

Une variable scalaire (x=5 : affectation de la valeur 5 à la variable x) est vue par MATLAB 

comme une matrice de dimension 1x1 (ligne x colonne). Comme le montre l’exemple suivant 

dans lequel on affecte à la variable x la valeur 5 et on demande ensuite ses dimensions par la 

fonction 𝒔𝒊𝒛𝒆 (𝒙) dans l‘espace de Command Window: 
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>> x=5 

>> size(x) 
Utilisation de point-virgule 𝑎𝑛𝑠 (answer) 

 

Afin d’éviter l’affichage des 

résultats, il suffit de suivre la 

commande par un point-virgule 

(;). 

 

Matlab définit une 

variable ans, elle est 

une matrice de taille 

1x1 (une ligne par une 

colonne).  

 

 

Une commande 𝒄𝒍𝒄 : Cette commande permet de vider l’écran de Command Window pour 

voir une fenêtre propre. Une commande 𝒄𝒍𝒆𝒂𝒓 : Cette commande permet de supprimer 

toutes les variables dans l’espace  de Workspace pour repartir sur une 

fenêtre propre. 

 

Workspace (go to Window -> Workspace) 

Dans cette fenêtre, on obtient la liste des variables connues par Matlab. Il est 

possible de double-cliquer sur une variable pour l’afficher. Un clic-droit sur les 

variables donne de nombreuses options telles que : Copiez, Collez, Supprimez 

etc. 

 

Command History (go to Window -> Command History) 

L’espace Command History conserve une trace de toutes les 

opérations qui ont été réalisées sur l’espace Command Window. On 

peut également remonter dans la liste de commandes en se plaçant 

dans la Command Window et en pressant les flèches de direction 

↑  ↓.  

 

Current Folder (go to Window -> Current Folder) 

C’est le dossier qui contient le ficher de script, la programmation, le travail réaliser sur 

Matlab.  
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Help 

L’espace de l’aide est essentielle lorsque l’on programme avec un langage de haut-niveau 

comme Matlab, où le nombre de fonctions est très important et la syntaxe est parfois 

complexe. Pour accéder à l’aide on peut au choix sélectionner une fonction et presser F1 sur 

le clavier, ou bien taper dans l’espace Command Window : help cos, help input … etc.  Il est 

essentiel que vous vous familiarisiez avec les outils de l’aide de Matlab pour réussir dans ce 

Cours/TP. 

Command Description 

helpwin 

ouvre une fenêtre contenant la liste des commandes Matlab ainsi que 

leurs documentations 

help donne la liste de toutes les commandes par thèmes 

help nom  décrit la fonction nom.m 

lookfor nom  Recherche une instruction à partir du mot clé nom 

Use: help  Product Help to display the help Window 

 

 

Script 

Le script est le fichier avec l’extension ‘.m’ qui contient le programme plus simplement. Il 

s’agit d’une liste de commandes et des fonctions. 

 

Fonction 

Une fonction va permettre de rentrer des arguments en entrée et d’obtenir différentes 

variables en sortie.  

 

Editor  

La plupart de votre travail sous Matlab va consister à créer ou modifier des fichiers avec 

l’extension « .m » qui définit les fichiers de Matlab. Lorsque l’on réalise une tache sous 

Matlab, il est très souvent possible de le faire en utilisant uniquement la Command Window. 

Cependant lorsque cette tache devient plus complexe (plusieurs dizaines de ligne de code) 

ou que l’on souhaite pouvoir la transmettre à quelqu’un d’autre simplement, on utilise la 

fenêtre Editor. On crée un fichier .m qui peut être au choix un script ou une fonction.  
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Partie 02 : Partie Simulation (MATLAB – SIMULINK) 

Pour commencer on fixe le USERPATH, le dossier qui contient votre fichier (.m) 

 Crée un dossier dans le Bureau avec le nom : TP_INFO3. 

 Crée un autre dossier dans le dossier précédant avec le nom : TP01_02_INFO3. 

 Dans l’espace Current Folder, choisir le dossier TP01_02_INFO3 pour le 1er TP et 

ainsi de suite pour les autres TPs. 

 

 

Exercice1 : ”Hello World” 

Il s’agit d’un bref programme pour mettre en place les différents éléments nécessaires.  

 Crée ensuite new script (.m) dans le dossier TP01_INFO3. 

 Ecrire dans la 1ère ligne :  

1. varibale= 'Hello world'; 

Run  

 Sauvegarder le fichier avec le nom hello.m. 

Run  

Conclure ! 

 

Exercice2: ” Somme de deux nombres ” 

On va essayer ici de réaliser un script pour en faire une fonction qui prend deux nombres 

en entrée et retourne la somme des deux. 

 Cree un fichier new script (Ctrl +N). 

 Réaliser un programme qui va calculer la somme de deux nombres. 

 Sauvegarder avec le nom du fichier : Som_xy_TP1.m (utiliser le tiret de 8 « _ » et 

non « - ») 

 

Que remarquez-vous ? 

 

Exercice3: ” Somme de deux nombres quelconque ” 

On veut une fonction qui prend deux nombres aléatoire en entrée et renvoie par affichage 

la somme des deux. 

 Cree un fichier new script (Ctrl +N). Nommer : Som1_TP1.m, Sauvegarder !! 

 Ecrire la fonction :   
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 Run  

 Une erreur s’affiche : 

 

On a défini une fonction Som1_TP1(x,y) avec deux arguments, mais 

on a appelé la fonction sans arguments ; alors pour corriger cette 

erreur il faut donner une valeur à x et y, on l’appelle à la fonction 

Som1_TP1 dans l’espace Command Window par : On remarque 

que Matlab a affiché le variable z puisque nous n’avons pas utiliser le point-virgule et la 

variable par défaut ans. 

 

 Exercice4 : ” Comment trouver l’information voulue ” 

Utiliser l’espace Command Window 

 help log 

 help mod 

 

Exercice5: ” Somme de deux nombres quelconque par choix” 

On veut réaliser un programme qui prend trois chiffres par choix en entrée et renvoie un 

affichage de produit des premiers chiffres et la racine de produit des derniers nombres. 

 Cree un fichier new script (Ctrl +N), nommer : Som2_TP1.m, Sauvegarder !! 

 Ecrire la fonction :   

 

 

On a utilisé 4 fonctions « input (), sqrt(), dips() et fprintf() »,  

 Utiliser le « help input () » pour découvrir ces fonctions. 

Quelle est le but de ces fonctions ? 
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Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice5: ” Introduire Nom et Prénom ” 

On va essayer ici de réaliser un script pour en faire une fonction qui prend 2 arguments 

votre nom et prénom en entrée et retourne votre nom et prénom sur la même ligne en 

sortie.  

 Cree un fichier new script (Ctrl +N). Nommer : Name_TP1.m, Sauvegarder !! 

 

Exercice6: ” Introduire Nom et Prénom + la moyenne générale du 1ère année” 

On va réaliser un script pour une fonction qui prend 3 arguments votre nom et prénom et 

la moyenne générale de la 1ère année comme des entrées et renvoie votre nom et prénom 

et la moyenne sur la même ligne en sortie.  

 Cree un fichier new script (Ctrl +N). Nommer : Name1_TP1.m, Sauvegarder !! 
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TP 02 : Lecture, affichage et sauvegarde des données 

 

L’objectif de TP : 

Ce TP01 et TP02 a pour but de vous familiariser avec l’interface et les bases de 

l’environnement MATLAB afin d’utiliser quelques fonctions de base pour la lecture, 

l’affichage et le sauvegarde des données. 

 

 

Partie 01 : Partie théorique (l’interface de Matlab) 

Nous allons nous familiariser avec l’interface de Matlab. Selon la version utilisée, l’interface 

peut changer légèrement mais les points centraux resteront identiques. 

 

Command Windows 

Une variable scalaire (x=5 : affectation de la valeur 5 à la variable x) est vue par MATLAB 

comme une matrice de dimension 1x1 (ligne x colonne). Comme le montre l’exemple suivant 

dans lequel on affecte à la variable x la valeur 5 et on demande ensuite ses dimensions par la 

fonction 𝒔𝒊𝒛𝒆 (𝒙) dans l‘espace de Command Window: 
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>> x=5 

>> size(x) 
Utilisation de point-virgule 𝑎𝑛𝑠 (answer) 

 

Afin d’éviter l’affichage des 

résultats, il suffit de suivre la 

commande par un point-virgule 

(;). 

 

Matlab définit une 

variable ans, elle est 

une matrice de taille 

1x1 (une ligne par une 

colonne).  

 

 

Une commande 𝒄𝒍𝒄 : Cette commande permet de vider l’écran de Command Window pour 

voir une fenêtre propre. Une commande 𝒄𝒍𝒆𝒂𝒓 : Cette commande permet de supprimer 

toutes les variables dans l’espace  de Workspace pour repartir sur une 

fenêtre propre. 

 

Workspace (go to Window -> Workspace) 

Dans cette fenêtre, on obtient la liste des variables connues par Matlab. Il est 

possible de double-cliquer sur une variable pour l’afficher. Un clic-droit sur les 

variables donne de nombreuses options telles que : Copiez, Collez, Supprimez 

etc. 

 

Command History (go to Window -> Command History) 

L’espace Command History conserve une trace de toutes les 

opérations qui ont été réalisées sur l’espace Command Window. On 

peut également remonter dans la liste de commandes en se plaçant 

dans la Command Window et en pressant les flèches de direction 

↑  ↓.  

 

Current Folder (go to Window -> Current Folder) 

C’est le dossier qui contient le ficher de script, la programmation, le travail réaliser sur 

Matlab.  
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Help 

L’espace de l’aide est essentielle lorsque l’on programme avec un langage de haut-niveau 

comme Matlab, où le nombre de fonctions est très important et la syntaxe est parfois 

complexe. Pour accéder à l’aide on peut au choix sélectionner une fonction et presser F1 sur 

le clavier, ou bien taper dans l’espace Command Window : help cos, help input … etc.  Il est 

essentiel que vous vous familiarisiez avec les outils de l’aide de Matlab pour réussir dans ce 

Cours/TP. 

Command Description 

helpwin 

ouvre une fenêtre contenant la liste des commandes Matlab ainsi que 

leurs documentations 

help donne la liste de toutes les commandes par thèmes 

help nom  décrit la fonction nom.m 

lookfor nom  Recherche une instruction à partir du mot clé nom 

Use: help  Product Help to display the help Window 

 

 

Script 

Le script est le fichier avec l’extension ‘.m’ qui contient le programme plus simplement. Il 

s’agit d’une liste de commandes et des fonctions. 

 

Fonction 

Une fonction va permettre de rentrer des arguments en entrée et d’obtenir différentes 

variables en sortie.  

 

Editor  

La plupart de votre travail sous Matlab va consister à créer ou modifier des fichiers avec 

l’extension « .m » qui définit les fichiers de Matlab. Lorsque l’on réalise une tache sous 

Matlab, il est très souvent possible de le faire en utilisant uniquement la Command Window. 

Cependant lorsque cette tache devient plus complexe (plusieurs dizaines de ligne de code) 

ou que l’on souhaite pouvoir la transmettre à quelqu’un d’autre simplement, on utilise la 

fenêtre Editor. On crée un fichier .m qui peut être au choix un script ou une fonction.  
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Partie 02 : Partie Simulation (MATLAB – SIMULINK) 

Pour commencer on fixe le USERPATH, le dossier qui contient votre fichier (.m) 

 Crée un dossier dans le Bureau avec le nom : TP_INFO3. 

 Crée un autre dossier dans le dossier précédant avec le nom : TP01_02_INFO3. 

 Dans l’espace Current Folder, choisir le dossier TP01_02_INFO3 pour le 1er TP et 

ainsi de suite pour les autres TPs. 

 

 

Exercice1 : ”Hello World” 

Il s’agit d’un bref programme pour mettre en place les différents éléments nécessaires.  

 Crée ensuite new script (.m) dans le dossier TP01_INFO3. 

 Ecrire dans la 1ère ligne :  

1. varibale= 'Hello world'; 

Run  

 Sauvegarder le fichier avec le nom hello.m. 

Run  

Conclure ! 

 

Exercice2: ” Somme de deux nombres ” 

On va essayer ici de réaliser un script pour en faire une fonction qui prend deux nombres 

en entrée et retourne la somme des deux. 

 Cree un fichier new script (Ctrl +N). 

 Réaliser un programme qui va calculer la somme de deux nombres. 

 Sauvegarder avec le nom du fichier : Som_xy_TP1.m (utiliser le tiret de 8 « _ » et 

non « - ») 

 

Que remarquez-vous ? 

 

Exercice3: ” Somme de deux nombres quelconque ” 

On veut une fonction qui prend deux nombres aléatoire en entrée et renvoie par affichage 

la somme des deux. 

 Cree un fichier new script (Ctrl +N). Nommer : Som1_TP1.m, Sauvegarder !! 

 Ecrire la fonction :   
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 Run  

 Une erreur s’affiche : 

 

On a défini une fonction Som1_TP1(x,y) avec deux arguments, mais 

on a appelé la fonction sans arguments ; alors pour corriger cette 

erreur il faut donner une valeur à x et y, on l’appelle à la fonction 

Som1_TP1 dans l’espace Command Window par : On remarque 

que Matlab a affiché le variable z puisque nous n’avons pas utiliser le point-virgule et la 

variable par défaut ans. 

 

 Exercice4 : ” Comment trouver l’information voulue ” 

Utiliser l’espace Command Window 

 help log 

 help mod 

 

Exercice5: ” Somme de deux nombres quelconque par choix” 

On veut réaliser un programme qui prend trois chiffres par choix en entrée et renvoie un 

affichage de produit des premiers chiffres et la racine de produit des derniers nombres. 

 Cree un fichier new script (Ctrl +N), nommer : Som2_TP1.m, Sauvegarder !! 

 Ecrire la fonction :   

 

 

On a utilisé 4 fonctions « input (), sqrt(), dips() et fprintf() »,  

 Utiliser le « help input () » pour découvrir ces fonctions. 

Quelle est le but de ces fonctions ? 
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Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice5: ” Introduire Nom et Prénom ” 

On va essayer ici de réaliser un script pour en faire une fonction qui prend 2 arguments 

votre nom et prénom en entrée et retourne votre nom et prénom sur la même ligne en 

sortie.  

 Cree un fichier new script (Ctrl +N). Nommer : Name_TP1.m, Sauvegarder !! 

 

Exercice6: ” Introduire Nom et Prénom + la moyenne générale du 1ère année” 

On va réaliser un script pour une fonction qui prend 3 arguments votre nom et prénom et 

la moyenne générale de la 1ère année comme des entrées et renvoie votre nom et prénom 

et la moyenne sur la même ligne en sortie.  

 Cree un fichier new script (Ctrl +N). Nommer : Name1_TP1.m, Sauvegarder !! 
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TP 03 : Fichiers script et Types de données et de variables 

 

L’objectif de TP : 

Ce TP03 a pour but de vous découvrir les opérations de base ainsi les types de variables ainsi 

leurs utilisations dans la résolution des exercices.  

 

Partie 01 : Partie théorique (Types de données et de variables) 

Outils de base 

On l’a déjà dit, le principe de base de Matlab est de considérer la plupart des objets comme des 

matrices. Ainsi les opérations usuelles +, −,∗,/ doivent se comprendre comme des opérations 

matricielles.  

On consacrera la section suivante à ces opérations. Nous allons dans un premier temps regarder ce 

qu’ils se passent pour les matrices 1x1 (c’est à dire un seul élément). 

 

Types de données de variables 

Il existe cinq grands types de variables sous Matlab :  

 NOMBRES (les entiers, les réels, les complexes),  

 CARACTERES (les chaînes de caractères),  

 LOGIQUE (1 ou 0).  

 Définissons une variable de chaque type : 

  

La variable ‘a’ représente un réel, b un complexe, c une chaine de caractères, d1 et d2 sont deux 

manières de définir une variable logique (VRAI dans le cas présent) et e est un entier codé sur 8 bits. 

On peut alors vérifier le type de ces différentes variables en utilisant la fonction 𝒘𝒉𝒐𝒔 : 

 

 Utiliser les fonctions 𝒊𝒔𝒄𝒉𝒂𝒓(𝒗𝒂𝒓𝒊𝒂𝒃𝒍𝒆𝒔), 𝒊𝒔𝒍𝒐𝒈𝒊𝒄𝒂𝒍(… ), 𝒊𝒔𝒓𝒆𝒂𝒍(… ). 

 Conclure !! 
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Variables MATLAB 

Les noms des variables et de fonctions sont composés de lettres et chiffres. Matlab fait la distinction 

entre les majuscules et minuscules, i.e. INFO3, info3 et Info3 sont des   variables différentes. Si la 

variable existe déjà, le contenu est écrasé par une nouvelle valeur affectée à cette variable. 

 

Variable : 

Dans Matlab il y a un seul type de données: le type de matrice (matrix). 

Matrice Vecteur Scalaire 

m x n, m, n >1, 1 x n, n >1, 1 x 1 

 

Nombres ou chaînes de caractères : 

Nom de variable Nombres ‘1, 2, 3, …’ 

chaînes de caractères 1, 2, (1+i)….  chaînes de caractères 

 

Classes and Format 

Par la syntaxe introduite ci-dessus, MATLAB définit des variables qui appartiennent à la classe 

double array, c’est à dire des tableaux de réels qui peuvent correspondre à des scalaires, des 

vecteurs ou des matrices. Mise à part cette classe fondamentale, il faut signaler qu’il existe d’autres 

classes MATLAB prédéfinies. La plus importante est certainement char array, à laquelle 

appartiennent les chaînes de caractères, définies en utilisant ’…’. 

 

Format and Codage 

Le tableau suivant répertorie les caractères et les sous-types de conversion disponibles sur MATLAB. 

 
 
On va utiliser le codage des formats ci-après pour nos TPs : 

Numbers 
Format 

Conversion 
Declaration de 

variable 
Character 

Format 
Conversion 

Declaration de 
variable 

les entiers %d int variable Single %c 
char variable 

les réels %f float variable String %s 
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Classes 

Double / single char 

Format d’affichage 
Par défaut, Matlab affiche les résultats sous forme décimale. Ce format peut être changé à tout 

moment avec la fonction 𝒇𝒐𝒓𝒎𝒂𝒕 

Commande Affichage Exemple 

format short  décimal à 5 chiffres 31.416 

format long  décimal à 16 chiffres 31.41592653535879 

format bank  virgule fixe à 2 décimales  31.41 

format rat  fractionnaire  3550/113 

 

Arithmétique et opérations sur les scalaires 

On a déjà réalisé les opérations de base avec des variables et des fonctions sur le TP02, vous pouvez 

tester les exemples suivants: 

 

On peut également travailler sur Matlab comme une calculatrice numérique utilisant les fonctions 

trigonométriques, puissance, logarithmiques etc. 

Main mathematical function used in Matlab 

 

 

 



Fiche TP : 03                                       Fichiers script et Types de données et de variables 

Cours/TP : Informatique 3                - 17 -                   Dr. Ali Abderrazak TADJEDDINE 

 

 

 

Partie 02 : Partie Simulation (MATLAB – SIMULINK) 

 Crée un nouveau dossier dans le dossier TP_INFO3 avec le nom : TP03_INFO3. 

 Change Current folder (path) to TP03_INFO3 in Matlab. 

 

Exercice 01 

Créer un programme permet de réaliser la somme de 1 à 10. (𝑺 = 𝟏 + 𝟐 + ⋯ + 𝟏𝟎) 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : Som_TP3.m 

 

Exercice 02 

Chercher un programme permet de réaliser le produit de 3 à 7. (𝑃 = 3 ∗ 4 ∗ … ∗ 7) 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : Prod_TP3.m 

 

Exercice 03 

Créer un programme permet de calculer la racine carré d’un nombre. 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : Rac_TP3.m  

 

Exercice 04 

On cherche un programme permet de calculer le déterminant ∆= 𝑏2 − 4𝑎𝑐 d’un polynôme 

d’ordre 2. 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : Det_TP3.m  

 

Exercice 05 

Réaliser une fonction permet de calculer les deux solutions d’une équation d’un polynôme 

du 2ème ordre à partir des 3 coefficients (a, b, c). 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : 2ordr_TP3.m 

 

Soit le polynôme d’ordre 2 suivant : 𝑃(𝑥) = 𝑥2 + 8𝑥 + 16, les coefficients de polynôme sont : 

P=[1, 8, 16]  

Dans le cas général un polynôme d’ordre 2 s’écrit : 𝑃(𝑥) = 𝑎𝑥2 + 𝑏𝑥 + 𝑐 avec P=[a, b, c] et 

les racines sont : 𝑃(𝑥) = (𝑥 − 𝑟1)(𝑥 − 𝑟2) avec 𝑟1,2 =
−𝑏±√𝑏2−4𝑎𝑐

2𝑎
 

On cherche à utiliser une fonction Matlab permet de résoudre le polynôme d’ordre 2 : 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : 2ordr1_TP3.m 

 Utiliser les mêmes coefficients proposées dans la partie précédente, 

 Utiliser la fonction 𝒓𝒐𝒐𝒕𝒔() pour résoudre l’équation du polynôme. 
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        

 Comparer les résultats obtenus avec vos résultats du programme, Conclure ! 

 Utiliser la fonction 𝒑𝒐𝒍𝒚() pour construire les coefficients d’un polynôme à partir de 

ces racines  

     

 

Exercice 06 

Soit le polynôme suivant : 

𝑃(𝑥) =  𝑥7 − 37𝑥6 + 555𝑥5 − 4295𝑥4 + 17924𝑥3 − 37668𝑥2 + 30240𝑥 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : Pol_TP3.m 

En utilisant Matlab ;  

 Résoudre 𝑃(𝑥) = 0. 

 Calculer le polynôme 𝑃(𝑥) pour 𝑥 = 2, 𝑥 = 3. (utiliser la fonction 𝒑𝒐𝒍𝒚𝒗𝒂𝒍 (𝒑, 𝒙)) 

 

Exercice 07 

Soit les racines d’un polynôme : 

𝑅 = [7, 8, 9,5,0,2,6] 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : RacPol_TP3.m 

En utilisant Matlab ;  

 Chercher les coefficients du polynôme. 

 Quelle est l’ordre du polynôme. 

 Calcul la dérivée de la fonction polynomiale (utiliser la fonction 𝒑𝒐𝒍𝒚𝒅𝒆𝒓 (𝒑)) 

 Calcul la primitive de la fonction polynomiale (utiliser la fonction 𝒑𝒐𝒍𝒚𝒊𝒏𝒕 (𝒑)) 

 

Exercice 08 

Soit les polynômes suivants : 

𝑃1(𝑥) = 𝑥3 + 3𝑥2 − 24𝑥 − 80    et     𝑃2(𝑥) = 𝑥2 − 𝑥 − 20 et  𝑃3(𝑥) = 𝑥 + 4 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : divPol_TP3.m 

 Chercher les coefficients des polynômes. 

En utilisant Matlab ;  

 calculer les racines de 𝑃1(𝑥) et 𝑃2(𝑥). 

 Calculer le produit de convolution ℎ(𝑥) = 𝑃2(𝑥) ∗ 𝑃3(𝑥).(utiliser la 

fonction 𝒄𝒐𝒏𝒗(𝑷𝟐, 𝑷𝟑)) 
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 Calculer le produit de déconvolution ℎ(𝑥) = 𝑃2(𝑥) ∗ 𝑃3(𝑥).(utiliser la 

fonction 𝒅𝒆𝒄𝒐𝒏𝒗(𝑷𝟏, 𝑷𝟑)) 

 Conclure 

 

Exercice 09 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : nbrcmplx_TP3.m 

Entrer les nombres complexes suivants : 

𝑧1 =  1 + 𝑖 , 𝑧2 = 𝑧2 , 𝑧3  =  𝑒𝑖𝜋/4  

Cependant, i et j sont des variables MATLAB réservées pour l’indice des nombres complexes. 

 Calculer par Matlab les quantités suivantes : 

 La partie réelle des nombres complexes, affecter chaque partie à une variable.  

 La partie imaginaire des nombres complexes, affecter chaque partie à une 

variable.  

 Le conjugue de 𝑍1 𝑒𝑡 𝑍3. 

 Le module de chaque nombre et affecter à une autre variable. 

 L’argument de chaque nombre complexe. 

Utiliser les fonctions complexes dans le tableau Main mathematical function used in Matlab. 

 

Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 10 de préparation (pour l’enseignement en ligne) 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : EX10_TP3.m 

1. Evaluez les quantités suivantes dans Matlab avec 5 chiffres significatifs : 

 

2. Calculez 
𝟏𝟎𝟎

𝟖
−  𝟎. 𝟓 [

𝟒

𝟏𝟎
]

𝟐
. Commentez le résultat. 

3. Calculez 𝒆𝟏𝟒 𝒆𝒕 𝟑𝟖𝟐𝟖𝟎𝟏𝝅 jusqu’au 15ème chiffres significatifs. Quel est le plus grand ? 

4. Comparez la division à droite ‘/’ et la division à gauche ‘\’. Commentez. (Utiliser ALTGR 

+ 8 pour ‘\’) 

5. Trouvez la partie réelle et imaginaire des nombres complexes suivants : 

𝑒𝑖(3𝜋+4)  et 
1

1+𝑖
 et ln(−1) 

6. Calculez le module et l’argument des nombres complexes suivants : 

 

 

Exercice 11 

 Créer new script (Ctrl +N). Sauvegarder avec le nom du fichier : EX11_TP3.m 
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Soit le polynôme suivant : 

𝑃(𝑥) =  𝑥5 − 2𝑥4 − 8𝑥3 + 16𝑥2 + 16𝑥 − 32 

 Evaluer les valeurs de 𝑃(𝑥) pour les points 𝑥 =  0, 𝑥 =  1, 𝑥 =  2. 

 Calculer la dérivée de 𝑃(𝑥) 

 Calculer la primitive de 𝑃(𝑥) 

 Calculer le polynôme d’ordre 2 𝐺(𝑥) tel que 𝐺(𝑥) =
𝑃(𝑥)

𝑥3−6𝑥2+12𝑥−8
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TP 04 : Vecteurs et matrices 

 

L’objectif de TP : 

Ce TP04 a pour but de vous découvrir les opérations sur les vecteurs et les matrices afin de 

les utiliser pour la résolution des exercices.  

 

Partie 01 : Partie théorique (Vecteurs : Listes et tableaux) 

Matlab utilise principalement les listes (vecteurs) ou tableaux (matrices) pour le calcul. Il est 

utile de savoir manipuler ces objets des maintenant.  

Pour Matlab, une variable (a; x; . . .) ou une liste de nombres est un tableau particulier. 

On peut retenir, pour simplifier, que dans Matlab tout est matrice (une matrice est un 

tableau). Si cela peut paraître bizarre au début, c’est ce qui permet à Matlab d’être aussi 

puissant et rapide en calcul. 

 

Construction d’un Vecteurs (une liste) 

On peut définir une liste de nombres en donnant à la suite ses éléments sépares par des 

espaces ou des virgules. La liste est délimitée par des crochets []. 

La différence entre virgule, espace et point-virgule 

 
 

Vecteur à 3 éléments horizontales Vecteur à 3 éléments verticales 

 

La variable 𝑷 est considérée comme un tableau comportant une 

ligne et trois colonnes : 

1 8 16 
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Transposée d’un vecteur 

La transposée pour passer d’une ligne à une colonne ou réciproquement : 

>> vec1= [1 4 7] 

>> vec1’ 

 

Manipuler un vecteur 

Accès aux éléments d’une liste 

On peut extraire les éléments d’un vecteur. On accède l’élément d’indice k de 

la liste a avec 𝑷(𝒌). 

On cherche par exemple la 3ème valeur de vecteur P : 𝑃(3) 

 

Exemple1  

Soit : 𝑷𝟐(𝒙) =  𝒙𝟓 − 𝟐𝒙𝟒 − 𝟖𝒙𝟑 + 𝟏𝟔𝒙𝟐 + 𝟏𝟔𝒙 − 𝟑𝟐 

Le vecteur des coefficients du polynôme 𝑃2(𝑥) est définit par : P2=[1 -2 -8 16 -32]  

 

On cherche par exemple la 2ème valeur de 

vecteur de P2 : 𝑃2(2) 

 

On cherche les 3 premiers valeurs de vecteur 

de P2 : 𝑃2(1: 3) 

 

 

On cherche les valeurs des indices impaire de vecteur de P2 : 𝑃2(1: 2: 5) 

 

L’expression (𝒂 ∶ 𝒑 ∶ 𝒃) crée une liste dont les éléments vont de 𝒂 à 𝒃 avec un pas de 𝒑. 

Lorsqu’on ne donne pas le pas, la valeur du pas est par défaut 1. L’accès à un élément 

d’indice négatif conduit à une erreur. 

 

La taille d’un vecteur 

La commande 𝒍𝒆𝒏𝒈𝒕𝒉() permet de retourner le nombre d’élément dans un vecteur. 
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Concaténer deux vecteurs 

P3= [P2 vec1] 

Command linspace () 

𝒍𝒊𝒏𝒔𝒑𝒂𝒄𝒆(𝑿𝟏, 𝑿𝟐, 𝑵) generates: N points between X1 and X2, for N = 1, linspace returns 

X2. 

𝑃4 = 𝑙𝑖𝑛𝑠𝑝𝑎𝑐𝑒(1,10,10) 

 

 

Construction d’une matrice (un tableau) 

On peut créer des tableaux de nombres avec plusieurs lignes en donnant chaque ligne 

séparée par un point-virgule (; ). 

Soit : 𝑃3 = [1 − 2 − 8 16 − 32 ;  1 2 3 4 5] 

  

 

Accès aux éléments d’une matrice (un tableau) 

De même, on peut extraire des parties d’une matrice. Le premier nombre désigne la ligne et 

le deuxième nombre la colonne.  

 

Exemple2 

 Chercher la valeur d’élément (1,3) de la matrice P3 : 𝑷𝟑 (𝟏 , 𝟑) 

 Chercher les valeurs de la 4ème colonne (X,4) de la matrice P3 : 𝑷𝟑 (: , 𝟑) 

 Chercher les valeurs de la 2ème ligne (2, X) de la matrice P3 : 𝑷𝟑 (𝟐, 𝐗) 

 Chercher les valeurs de la 1ère ligne à partir du 3ème colonne de la matrice P3 : 

𝑷𝟑 (𝟏, 𝟑: 𝟓) 

 

Changement d’un élément dans la matrice  

 On veut modifier la valeur d’élément (1,3) par la valeur 100 : P3(1,3) =100. 



Fiche TP : 04                                         Vecteurs et matrices (MATLAB) 

Cours/TP : Informatique 3                - 24 -                   Dr. Ali Abderrazak TADJEDDINE 

 

 Autrement, dans l’espace Workspace, double-clic sur la matrice P3  (variable 

Editor), chercher l’élément (ligne 1, colonne 3), changer le par la valeur 100. 

 

Partie 02 : Partie Simulation (Opération sur les Matrices (tableaux)) 

 Crée un nouveau dossier dans le dossier TP_INFO3 avec le nom : TP04_INFO3. 

 Change Current folder (userpath) to TP04_INFO3 in Matlab. 

 

Toutes les opérations usuelles entre matrices et vecteurs sont disponibles (addition, 

multiplication, transposition etc.). Matlab permet aussi d’appliquer les principaux 

opérateurs éléments par éléments, il suffit en général de faire précéder l’opérateur voulu par 

un point ’’ . ’’ 

 

Soit les deux matrices A et B suivantes : 

𝐴 = (
8 1 6
3 5 7
4 9 2

) , 𝐴1 = (
4 1 2
6 1 6
3 3 1

) , 𝐵 = (
8 1
5 7

),  𝑉1 = (
5
4
6

) ,  𝑉2 = (2 1 6), 𝑉3 =

(4 9), 

 

Exercice 1 (Concaténer, Comparer les matrices) 

En utilisant Matlab (espace Command Window);  

 La matrice C comprend la matrice A et A1 horizontalement : C=[A, A1] 

 Utiliser la fonction 𝒄𝒂𝒕(𝒅𝒊𝒎, 𝑨,  𝑨𝟏) pour assembler les matrices A et A1 : C1=cat(2, 

A, A1) 

 Comparer la matrice C et C1, utiliser la fonction : 𝒊𝒔𝒆𝒒𝒖𝒂𝒍(𝑪, 𝑪𝟏) 

 Comparer la matrice A et A1, use : A==A1 

 Conclure !! 

 

Exercice 2 (Ajouter – Supprimer (ligne/colonne) dans une matrice) 

En utilisant Matlab (espace Command Window);  

 Calculer la dimension de la matrice A et B. 

 Calculer le nombre des éléments dans le vecteur V1 et V2. 

 Ajouter le vecteur V1 dans la 3éme colonne de matrice B. 

Méthode 1 Méthode 2 
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 Ajouter le vecteur V2 dans la 3éme ligne de matrice B. 

 

 Supprimer la deuxième ligne de matrice A et affecter la nouvelle matrice au C3. 

Méthode 1 Méthode 2 

 
 

 

Exercise 3 (Summation - product – transposition – square matrix) 

 Create a new script (Ctrl +N). Save with the name : EX3_TP4.m 

 Introduire les matrices dans le script. 

 Vérifier les matrices par l’exécution de programme . 

 Calculer les dimensions de 𝐴, 𝐴1, 𝐵, 𝑉1, 𝑉2 𝑒𝑡 𝑉3. 

 Calculer la matrice transposée de A et B : transpose (A), B’. 

 Calculer la matrice carrée de B : B^2. 

 A partir de la matrice A, extraire la sous matrice 𝐴2 = (3,5 ; 4,9) 

 Calculer la somme des matrices A et A1 : 𝑆𝑜𝑚 = 𝐴 + 𝐴1 ; 

 Calculer la somme des matrices B et A2 : 𝑆 = 𝐵 + 𝐴2 ; 

 Calculer la somme des matrices A et C3 : 𝑆𝑜𝑚1 = 𝐴 + 𝐶3 ; 

 

Pour calculer la somme des deux matrices, les dimensions des matrices doivent être les 

mêmes. 

 Calculer le produit des matrices A et V1 : 𝑝𝑟𝑑 = 𝐴 ∗ 𝑉1 ; 
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 Vérifier manuellement le résultat. 

 

Pour le produit il faut que la dimension de la colonne de la première matrice égale à la 

dimension de la ligne de la deuxième matrice (𝒏, 𝒎) ∗ (𝒏’, 𝒎’)  ≫  𝒎 = 𝒏’ 

 

Exercice 4 (matrices particulières) 

En utilisant Matlab (espace Command Window);  

 Matrice d’identité : utiliser la commande eye(n,m) : 1) (n=3,m=1), 2) (n=3,m=2), 3) 

(n=3,m=3). 

 Matrice nulle : utiliser la commande zeros(n,m) : 1) (n=3,m=1), 2) (n=3,m=2), 3) 

(n=3,m=3). 

 Matrice unitaire :  utiliser la commande ones(n,m) : 1) (n=3,m=1), 2) (n=3,m=2), 3) 

(n=3,m=3). 

 Matrice aléatoire : utiliser la commande rand(n,m) : 1) (n=3,m=1), 2) (n=3,m=2), 3) 

(n=3,m=3).  

 Matrice Magique : utiliser la commande magic(n). 

Exercice 5 (introduire une matrice (2,2)) 

 Create a new script (Ctrl +N). Save with the name : EX5_TP4.m 

 Réaliser une fonction qui prend 4 nombres en entrées et renvoie en sortie une matrice 

𝑀(2,2).  

Utiliser la commande zeros (n,m) pour initier la matrice 𝑀(2,2). 

 

Exercice 6 (introduire une matrice (2,2) par l’utilisateur) 

 Create a new script (Ctrl +N). Save with the name : EX6_TP4.m 

 Réaliser une fonction qui prend 4 nombres en entrées par l’utilisateur et renvoie en 

sortie une matrice 𝑀1(2,2). 𝑀1 = (
𝑚11 𝑚12

𝑚21 𝑚22
) 

Utiliser la commande 𝑚11 = 𝒊𝒏𝒑𝒖𝒕 (‘𝑒𝑛𝑡𝑟𝑒 𝑙𝑒 1𝑒𝑟 𝑛𝑜𝑚𝑏𝑟𝑒 ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝑀1(2,2). 

 

Exercice 7 (introduire une matrice (3,3) par l’utilisateur) 

 Create a new script (Ctrl +N). Save with the name : EX7_TP4.m 

 Réaliser une fonction qui prend 9 nombres en entrées par l’utilisateur et renvoie en 

sortie une matrice 𝑀2(3,3).  

Utiliser la commande vera11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝑀2(3,3). 
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Exercice 8 (Sommation Matrice(2,2) + Matrice(2,2) par choix) 

 Create a new script (Ctrl +N). Save with the name : EX8_TP4.m 

 On cherche à réaliser une fonction qui faire la sommation entre deux 𝑚𝑎𝑡𝑟𝑖𝑐𝑒 𝐴 +  𝐵.  

 

Exercice 9 (Multiplication Matrice(3,3) x Vecteur(3,1) par choix) 

 Create a new script (Ctrl +N). Save with the name : EX9_TP4.m 

 On cherche de réaliser une fonction qui faire le produit entre matrice(3,3) et un 

vecteur(3,1) entrée par l’utilisateur et affiche en sortie le résultat.  

Utiliser la commande b11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝑀2(3,3). 

 

Exercice 10 (résoudre d’un système linéaire matricielle AX=Y) 

 Create a new script (Ctrl +N). Save with the name : EX10_TP4.m 

 Réaliser une fonction qui résoudre l’équation matricielle 𝐴𝑋 = 𝑌 et affiche en sortie 

le résultat du X, avec la matrice A(3,3), les vecteurs Y(3,1), X(3,1). 

 Mesurer le temps d’exécution du programme en seconde ; use command tic ; and 

toc ; 

Utiliser la commande a11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝐴(3,3). 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier le vecteur 𝑋(3,1). 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier le vecteur 𝑌(3,1). 

Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 11 de préparation (déterminant d’une matrice) 

 Create a new script (Ctrl +N). Save with the name : EX11_TP4.m 

 Réaliser une fonction qui renvoie le déterminant d’une matrice 𝑵(𝟐, 𝟐) donnée par 

l’utilisateur. 

Utiliser la commande var11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝑁(2,2). 

 

Exercice 12 de préparation (inversement d’une matrice (2,2)) 

 Create a new script (Ctrl +N). Save with the name : EX12_TP4.m 

 Réaliser une fonction qui inverse une matrice 𝑳(𝟐, 𝟐) donnée par l’utilisateur. 

Utiliser la commande a11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝐿(2,2). 

 

Exercice 12 de préparation (inversement d’une matrice(3,3)) 

 Create a new script (Ctrl +N). Save with the name : EX12_TP4.m 

 Réaliser une fonction qui inverse une matrice 𝑮(𝟑, 𝟑) donnée par l’utilisateur. 

Utiliser la commande G11=input (‘entre le 1er nombre ‘) ; 

Utiliser la commande 𝒛𝒆𝒓𝒐𝒔(𝒏, 𝒎) pour initier la matrice 𝐺(3,3). 
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TP 05: Instructions de contrôle (Instructions: if & switch) 

 

L’objectif de TP : 

Ce TP05 a pour but de vous découvrir les instructions et les conditions de contrôle. La 

structure conditionnelle permet d’exécuter une action si et seulement si un test préalable et 

renvoie la valeur ’VRAI’.  

 

Partie 01 : Partie théorique (les Instructions conditionnées: if & switch) 

Il existe deux commandes possibles permettant de réaliser des tests de conditions sur les 

données.  

L’instruction 𝒊𝒇() permet de tester la valeur d'une variable et d'effectuer différents 

traitements suivant les cas testés.  

L’instruction 𝒔𝒘𝒊𝒕𝒄𝒉() permet de choisir entre différents cas, et de faire correspondre un 

traitement adapté à chacun des cas reconnus. 

Les opérateurs de comparaison et les opérateurs logiques sont utilisés essentiellement dans 

les instructions de contrôle : 

Opérateurs de comparaison 

(relationnels) 

 Strictement supérieur : (X > Y) 

 Strictement inférieur : (X< Y)  

 Comparer deux objets : (X= = Y) 

 Supérieur ou égale : (X>= Y) 

 Inférieur ou égale : (X<= Y) 

 Différent de : (X~=Y) 

Opérateurs logiques 

 And : & : (X &Y) 

 Or :│ : (X │ Y) 

 Not : X (-X) 

 

 

L’instruction 𝑰𝒇 . . . 𝒆𝒍𝒔𝒆𝒊𝒇 . . .  𝒆𝒍𝒔𝒆 . . . 𝒆𝒏𝒅 

Exécuter instruction ou un groupe des instructions si la 

condition est vraie. 

 

𝒆𝒍𝒔𝒆𝒊𝒇 & 𝒆𝒍𝒔𝒆 : sont facultatifs et n'exécutent les instructions 

que lorsque les expressions précédentes du bloc 𝒊𝒇 sont fausses. 

Un bloc 𝒊𝒇 peut inclure plusieurs instructions 𝒆𝒍𝒔𝒆𝒊𝒇. 
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 Expression logique est une expression dont le résultat peut être vrai ou faux (donnée 

logique); 

 Séquence d'instructions (statements) est le traitement à effectuer si l’expression 

logique est vraie. 

 

Description 

Les expressions peuvent inclure des opérateurs relationnels (tels que < ou ==) et des 

opérateurs logiques (tels que &&, || ou ~). MATLAB évalue les expressions composées de 

gauche à droite, en respectant les règles de priorité des opérateurs. 

 Vous pouvez utiliser n'importe quel nombre d'instructions if, chaque instruction if 

nécessite end. 

 Évitez d'ajouter un espace dans elseif (else if). L'espace crée une nouvelle instruction 

if imbriquée qui requiert son propre mot-clé de fin. 

 

Example 1 (Instructions conditionnées if-else-end) 

 Create a new folder with name TP05_INFO3 in folder TP_INFO3.  

 Change Current folder (userpath) to TP05_INFO3 in Matlab. 

 Create a new script (Ctrl +N). Save with the name : Exemple1_TP5.m 

 Affecter les valeurs suivantes (5,1,10/2) aux variables (a,b,c) successives: 

Description : Script : 

Les lignes (1,2,3) : Initiation 

 Initiation des valeurs de variables. 

Les lignes (5 à 8) : teste 

 L’instruction if : teste la variable a est différente de c 

(valeur !!) 

Si la valeur de 𝒂 = 5 est différente de 𝒄 =
10

2
= 5 

Alors calculer : 

la nouvelle valeur de 𝒃 = (𝒂𝒏𝒄𝒊𝒆𝒏 𝒃 = 𝟏) + 𝟏 = 𝟏 + 𝟏 = 𝟐 

disp(‘b=’) : afficher dans l’espace CW l’expression : b= 

disp(b) : afficher la valeur de b : 2 ; 

Les lignes (9 à 14) : contre le teste 

 L’instruction else : ‘’teste la variable a est égale à c’’ 

Non la valeur de 𝒂 = 𝟓 est égal de 𝒄 =
𝟏𝟎

𝟐
= 𝟓 

Alors : 

disp(a), disp(c) : afficher dans l’espace CW l’expression la valeur de 

la variable a et c. 

b=b-1 : calcule de la nouvelle valeur de b et affecter à b 

disp(‘b=’) : afficher dans l’espace CW l’expression : b= 
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disp(b) : afficher la valeur de b : 0 ; 

La ligne (15) : fin  

 L’instruction end : termine et ferme la condition if. 

 

Example 2 (Instructions conditionnées if-elseif-end) 

 Create a new script (Ctrl +N). Save with the name : Exemple2_TP5.m 
 On cherche une fonction qui affiche une matrice carrée de taille n ; soit zeros(), 

ones() ou bien rand() selon les entrée 1 ou 2 ou 3.  
 Utiliser l’instruction 𝒊𝒇. 

 

 

L’instruction 𝒔𝒘𝒊𝒕𝒄𝒉() . . . 𝒄𝒂𝒔𝒆 . . .  𝒐𝒕𝒉𝒆𝒓𝒘𝒊𝒔𝒆 . . . 𝒆𝒏𝒅  

L’instruction switch exécute conditionnellement un 

ensemble d'instructions parmi plusieurs choix nombres, 

chaînes, objets. Chaque choix est un cas. 

 

Une ‘switch_expression’ tester un scalaire ou une 

chaîne de caractères. Le bloc de commutation teste 

chaque cas jusqu'à ce que l'un des cas soit vrai.   

 If un cas est vrai, MATLAB exécute les instructions correspondantes, puis quitte le 

bloc de commutation. 

 Sinon (otherwise) s'exécute uniquement lorsqu'aucune casse n'est vraie. 
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Exemple 3 (Instructions conditionnées, Nombres : 𝒔𝒘𝒊𝒕𝒄𝒉 …  𝒄𝒂𝒔𝒆 …  𝒆𝒏𝒅) 

 Create a new script (Ctrl +N). Save with the name : Exemple3_TP5.m 

 On cherche une fonction qui affiche une matrice carrée de taille n soit zeros(), ones() 

ou bien rand() selon les entrée 1 ou 2 ou 3.  

 Utiliser l’instruction 𝒔𝒘𝒊𝒕𝒄𝒉. 

 

 

Partie 02 : Partie Simulation (Conditions) 

Exercice 1 (teste d’une variable réelle : if) 

 Create a new script (Ctrl +N). Save with the name : EX1_TP5.m 

 Réaliser une fonction qui teste une variable réelle a si positive, nulle ou négative et 

renois par affichage. 

 Utiliser l’instruction if. 

 

Exercice 2 (teste d’une variable réelle : switch) 

 Create a new script (Ctrl +N). Save with the name : EX2_TP5.m 

 Réaliser une fonction qui teste une variable réelle a si positive, nulle ou négative et 

renvois par affichage. 

 Utiliser l’instruction switch. 

 

Exercice 3 (Enregistrement d’un fichier) 

 Create a new script (Ctrl +N). Save with the name : EX3_TP5.m 

 Réaliser une fonction qui affiche « Voulez-vous enregistrer ? écrire Y ou N : » et elle 

renvois par affichage l’enregistrement ou l’annulation du fichier. 

 Utiliser l’instruction if. 

 Réutiliser l’instruction switch. 
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Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 4 (teste d’inversement d’une matrice) 

 Create a new script (Ctrl +N). Save with the name : EX4_TP5.m 

 Create a random matrix of size 3. 𝑨𝒎 = 𝒓𝒂𝒏𝒅(𝟑); 

 Réaliser une fonction qui renvoi l’inversement d’une matrice si possible ou bien 

erreur d’inversement si le déterminant d’une matrice égale à 0. 

 Use instruction: 𝒊𝒇  

 Use instruction: 𝒊𝒏𝒗(𝒎𝒂𝒕𝒓𝒊𝒙) 

 Use instruction: 𝒆𝒓𝒓𝒐𝒓(′erreur d’inversement′) 

 Pour le teste : Utiliser la matrice carrée suivante : 𝑀 = [2, 4, 6; 3, −8, −5; 5, −4,1]. 

Exercice 5 de préparation (Ajouter le teste d’inversement d’une matrice à 

l’EX12_TP4) 

 Create a new script (Ctrl +N). Save with the name : EX5_TP5.m 

 Copier le script de l’exercice EX12_TP4.m dans le script d’EX5_TP5. 

 Modifier le script en ajoutant la fonction qui renvoi le teste d’inversement d’une 

matrice si possible ou bien erreur d’inversement si le déterminant d’une matrice 

égale à 0. 

 Use instruction: switch.  

 Pour le teste : Utiliser la matrice carrée suivante : 𝑴 = [𝟐, 𝟒, 𝟔; 𝟑, −𝟖, −𝟓; 𝟓, −𝟒, 𝟏]. 

 

Exercice 6 de préparation (Ajouter un test pour polynôme 2ème dégrée) 

 Create a new script (Ctrl +N). Save with the name : EX6_TP5.m 

 Copier le script de l’exercice 2ordr_TP3.m dans le script d’EX6_TP5. 

 Créons un programme qui trouve les racines d’une équation de second degré 𝑎𝑥^2 +

𝑏𝑥 + 𝑐 = 0 avec les conditions du discriminant. 
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TP 06: Instructions de contrôle (Boucle: for & while) 

 

L’objectif de TP : 

Ce TP06 a pour but de vous découvrir les instructions de contrôle ainsi les opérations sur les 

boucles, cette dernière, elle permet de répéter la même commande à un grand nombre de 

fois en faisant varier un paramètre.  

 

Partie 01 : Partie théorique (Boucle: for & while) 

L’instruction : 𝒇𝒐𝒓 . . . 𝒆𝒏𝒅 

L’instruction 𝒇𝒐𝒓 (pour) s’exécute une/plusieurs instructions MATLAB dans une boucle de 

répétition avec une/plusieurs condition. C’est plus pratique pour la définition des suites par 

récurrences comme nous le verrons.  

 

Corps de la boucle 𝒇𝒐𝒓  

 Indice : est une variable appelée l'indice de la 

boucle; 

 Borne_inf et Borne_sup : sont deux constantes 

réelles (appelées paramètres de la boucle); 

 Séquence d'instructions : est le traitement à effectuer pour les valeurs d'indices 

variant entre borne_inf et borne_sup avec un incrément de 1. 

 

 Pour forcer une sortie immédiate de la boucle, utilisez une instruction 

𝒃𝒓𝒆𝒂𝒌 𝑜𝑢 𝒓𝒆𝒕𝒖𝒓𝒏. 

 Pour parcourir les valeurs d'un seul vecteur colonne, transposez-le d'abord pour 

créer un vecteur ligne. 

 

Example 1 

 Create a new script (Ctrl +N). Save with the name : Exemple1_TP6.m 

 Réaliser une fonction Matlab qui compte de 1 jusqu’à 10. 

 Use instruction: for.  
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Example 2 

 Create a new script (Ctrl +N). Save with the name : Exemple2_TP6.m 

 Use instruction: for.  

 Réaliser une fonction qui affiche les 

nombres d’itérations de 0 jusqu'à 𝑛.  

 Modifier la fonction d’afficher de 𝑛/2 

jusqu’à 𝑛. 

  

 

Example 3 

 Create a new script (Ctrl +N). Save with the name : Exemple3_TP6.m 

 Use instruction: for.  

 On cherche une fonction qui calcule la 

somme de 1 à 𝑛.  

𝑆 =  1 + 2 + 3 + 4 + ⋯ + 𝑛 

 Modifier la fonction, On cherche 

de calculer la somme de 𝑎 à 𝑏.  

𝑆𝑎𝑏  =  𝑎 + 1 + 2 + ⋯ + 𝑏 

  

 

L’instruction : 𝒘𝒉𝒊𝒍𝒆 . . . 𝒆𝒏𝒅 

L’instruction 𝒘𝒉𝒊𝒍𝒆 (tant que) exécute une/plusieurs instructions tant que la condition est 

vraie. 

 

Corps de la boucle 𝒘𝒉𝒊𝒍𝒆 

 Expression logique : est une expression dont le résultat 

peut être vrai ou faux; 

 Séquence d'instructions : est le traitement à effectuer 

tant qu’expression logique est vraie. 

 

 

 

Remarque 
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𝑬𝒙𝒑𝒓𝒆𝒔𝒔𝒊𝒐𝒏 𝒍𝒐𝒈𝒊𝒒𝒖𝒆 est en général le résultat d'un test (par exemple i < Imax) ou le 

résultat d'une fonction logique (par exemple all(x)). Il est impératif que le traitement de la 

𝒔é𝒒𝒖𝒆𝒏𝒄𝒆 𝒅′𝒊𝒏𝒔𝒕𝒓𝒖𝒄𝒕𝒊𝒐𝒏𝒔 agisse sur le résultat 𝒅’𝒆𝒙𝒑𝒓𝒆𝒔𝒔𝒊𝒐𝒏 𝒍𝒐𝒈𝒊𝒒𝒖𝒆 sans quoi on 

boucle indéfiniment. 

 

Example 4 

 Create a new script (Ctrl +N). Save with the name : Exemple4_TP6.m 

 Use instruction: while.  

 Réaliser une fonction Matlab qui 

compte de 1 jusqu’à 10. 

 Use exemple Exepmle1_TP6 

 Ecrire une fonction Matlab qui 

permet de calculer la somme de 1 

jusqu’à n. 

 Use exemple Exepmle3_TP6 

 

 

 

Example 5 

 Create a new script (Ctrl +N). Save with the name : Exemple5_TP6.m 

 Use instruction: while.  

 Réaliser une fonction Matlab qui calcule le produit de 1 jusqu’à 𝑛. 

 

 Réaliser une fonction Matlab qui permet de calculer la factorielle de 𝑛. 
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Partie 02 : Partie Simulation (Conditions) 

Exercise 1 (display elements of any vector) 

 Create a new script (Ctrl +N). Save with the name : Exercice1_TP6.m 

 Réaliser une fonction qui affiche les éléments d’un vecteur un-par-un sur la même 

ligne.  

 Créer un vecteur de 1 à n nombres (n<20). 

 Use instruction: for/while. 

 

 

 

Exercise 2 (display elements of matrix) 

 Create a new script (Ctrl +N). Save with the name : Exercice2_TP6.m 

 Créer une matrice 𝑀 = [1 2 3;  3 4 5;  6 7 8]; 

 Réaliser une fonction qui affiche les éléments d’une matrice un-par-un.   

 Use boucles: for ou while (il faut utiliser 2 boucles). 
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Exercise 3 (display elements of matrix) 

 Create a new script (Ctrl +N). Save with the name : Exercice3_TP6.m 

 Réaliser une fonction qui affiche les éléments d’une matrice aléatoire de dimension n 

un-par-un.   

 

 

Exercise 4 (display elements of matrix) 

 Create a new script (Ctrl +N). Save with the name : Exercice4_TP6.m 

 Réaliser une fonction qui affiche la 3ème ligne d’une matrice magique de dimension 5.   

 

 

Exercise 5 (introduce a matrix element by element) 

 Create a new script (Ctrl +N). Save with the name : Exercice5_TP6.m 

 Réaliser une fonction qui introduire élément-par-élément une matrice carrée de 

dimension n. 

 Use instruction: for/while.  
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Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 6 de préparation (teste d’inversement d’une matrice) 

 Create a new script (Ctrl +N). Save with the name : Exercice6_TP6.m 

 Réaliser une fonction qui contient une matrice carrée M d’ordre 12 contenant les 

entiers de 1 à 144 rangés par ligne.  

 Calculer le déterminant de M. 

 Calculer l’inverse de la matrice M.  

 Extraire de cette matrice : 

 Une sous-matrice A formée par les coefficients 𝑨𝒊𝒋 pour : 𝟏 < (𝒊, 𝒋) < 𝟔; 

 Une sous-matrice B d’ordre 3 formée par les premiers coefficients pairs de 𝑴𝒊𝒋. 

 Modifier par la valeur de zéros toutes les valeurs du diagonal de la matrice M. 
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TP 07 : Graphisme (Gestion des fenêtres graphiques, plot(), fplot()) 

 

L’objectif de TP : 

Ce TP07 a pour but de vous découvrir la gestion des fenêtres graphiques et les outils pour 

réaliser des graphes scientifiques de qualité présentant clairement les données scientifiques.  

 

Partie 01 : Partie théorique (Gestion des fenêtres graphiques 2D) 

S’il est utile de pouvoir faire des calculs numériques, il est aussi utile d’avoir une 

représentation graphique des résultats.  

On va commencer par tracer le graphe d’une fonction, la commande principale qui permet 

de tracer un graphe sous Matlab est l’instruction 𝒑𝒍𝒐𝒕() ou bien 𝒇𝒑𝒍𝒐𝒕().  

 

La commande 𝒑𝒍𝒐𝒕() 

l’instruction 𝒑𝒍𝒐𝒕() permet de tracer 

graphiquement 2D un ensemble de points de 

coordonnées : 

(𝒙𝒊 ,  𝒚𝒊),  𝒂𝒗𝒆𝒄 𝒊 = 𝟏, … , 𝑵 

Où  

𝒙 : est le vecteur contenant les valeurs 𝒙𝒊 en abscisse, et  

𝒚 : est le vecteur contenant les valeurs 𝒚𝒊 en ordonnée.  

Bien entendu les vecteurs x et y doivent être de même dimension mais il peut s'agir de 

vecteurs lignes ou colonnes. Par défaut, les points (xi, yi) sont reliés entre eux par des 

segments de droites. 

 

La première chose à faire est donc de regarder Syntaxe de la fonction (et de la comprendre) 

: 

 L’instruction Plot prend un, deux ou trois arguments, ou des multiples de trois ; 

 S’il n’y a qu’un seul argument, plot dessine la valeur du vecteur passe en argument, 

en fonction de son index ; 

 S’il y a deux arguments X et Y, plot dessine Y en fonction de X ; 

 Le troisième argument permet de passer des options :  
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(Changer la couleur, l’apparence du graphique etc.) 

 

Exemple 1  

 Create a new script (Ctrl +N). Save with the name : Exemple1_TP7.m 

 Tracer le graphe de la fonction 𝑓(𝑥) =  5𝑥 + 2 entre −5 𝑒𝑡 + 5 : 

 
 Comparer avec l’instruction 𝒑𝒍𝒐𝒕(𝒇); utiliser 𝑯𝒐𝒍𝒅 𝒐𝒏 pour afficher les deux 

fonctions sur la même figure. 

 

Exemple 2 

 Create a new script (Ctrl +N). Save with the name : Exemple2_TP7.m 

 Tracer le graphe de la fonction 𝑔(𝑥) =  5𝑥 + 2 entre −5 𝑒𝑡 + 5 : 

 
 

Exemple 3 

 Create a new script (Ctrl +N). Save with the name : Exemple3_TP7.m 

 Tracer le graphe de la fonction 𝑦(𝑥) =  𝑥 ∗ sin (𝑥) entre −𝟐𝝅 𝒆𝒕 𝟐𝝅 : 

 

 Utiliser l’instruction 𝒈𝒓𝒊𝒅 pour un quadrillage dans la figure. 

 

Exemple 4 

 Create a new script (Ctrl +N). Save with the name : Exemple4_TP7.m 

 Tracer le graphe de la fonction 𝑦1(𝑥) =  𝑥 ∗ sin (𝑥) entre −𝟐𝝅 𝒆𝒕 𝟐𝝅 : 
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 Comparer les résultats des exemples 3 et 4, Conclue ! 

Dans les exemples précédents on a défini un vecteur 𝑥𝑖  de valeurs équi-réparties 

entre −𝟓 𝐞𝐭 𝟓  ou bien −𝟐𝛑 𝐞𝐭 𝟐𝛑  (avec un pas de 0.001 et 0.01 dans le premier cas et 

de 1 dans le deuxième cas) et on a calculé l'image par la fonction 𝑓, 𝑔, 𝑦 𝑜𝑢 𝑦1 de ces valeurs 

(vecteur des images 𝑦𝑖), et par l’instruction plot on a affiché les points de coordonnées 

(𝑥(𝑖),  𝑦(𝑖)). 

 

Pour une courbe d’une fonction quelconque, on peut spécifier à MATLAB quelle doit être sa 

couleur, quel doit être le style de trait et/ou quel doit être le symbole à chaque point 

𝐴(𝑥𝑖 ,  𝑦𝑖).  

 

Pour cela on donne un troisième paramètre d'entrée à la commande plot qui est une chaîne 

de 3 caractères de la forme ′𝒄𝒔𝒕′ avec 𝒄 désignant la couleur du trait, 𝒔 le symbole du point 

et 𝒕 le type de trait. Les possibilités sont les suivantes: 

Couleur de trait symbole du point type de trait 

y jaune . point - trait plein 

m magenta o cercle : pointillé court 

c cyan x marque x - pointillé long 

r rouge + plus -. pointillé mixte 

g vert * étoile   

b bleu s carré   

w blanc d losange   

k noir v triangle (bas)   

^ triangle (haut)     

< triangle (gauche)     

> triangle (droit)     

p pentagone     

h hexagone     

 

Les valeurs par défaut sont ′𝑐 =  𝑏′,  ′𝑠 = . ′ 𝑒𝑡 ′𝑡 =  −′ ce qui correspond à un trait plein 

bleu reliant les points entre eux.  

 

Il n'est pas obligatoire de spécifier chacun des trois caractères. On peut se contenter d'en 

spécifier un ou deux. Les autres seront les valeurs par défaut. Il est possible de tracer 

plusieurs courbes sur la même figure en spécifiant plusieurs tableaux x1, y1, x2, y2, ..., 

comme paramètres de l’instruction 𝒑𝒍𝒐𝒕. Si l'on souhaite que les courbes aient une 

apparence différente, on utilisera des options de couleurs et/ou de styles de traits distincts 

après chaque couple de vecteurs x, y. 
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Sauvegarder une figure 

La commande 𝒑𝒓𝒊𝒏𝒕 permet de sauvegarder la figure d'une fenêtre graphique dans un 

fichier sous divers formats d'images. La syntaxe de la commande print est: 

𝒑𝒓𝒊𝒏𝒕 − 𝒇 < 𝒏𝒖𝒎 >  − 𝒅 < 𝒇𝒐𝒓𝒎𝒂𝒕 > < 𝒏𝒐𝒎𝒇𝒊𝒄 > 

D’où: 

 < 𝒏𝒖𝒎 > : désigne le numéro de la fenêtre graphique (figure 1, 2, …). 

 < 𝒇𝒐𝒓𝒎𝒂𝒕 > : désigne le format de sauvegarde de la figure. Ces formats sont 

nombreux. On pourra obtenir la liste complète en tapant help plot. Par exemple : 

Format d'image JPEG. 

 < 𝒏𝒐𝒎𝒇𝒊𝒄 > : désigne le nom du fichier dans lequel est sauvegardée la figure.  

 

Partie 02 : Partie Simulation (Conditions) 

Exercice 1 

 Create a new script (Ctrl +N). Save with the name : Exercice1_TP7.m 

 On trace sur l'intervalle 𝑥 ∈ [−5, 5] la fonction 𝒇(𝒙) = 𝒙² 𝒄𝒐𝒔(𝒙) en trait plein bleu, 

et la fonction 𝒈(𝒙) = 𝒙 𝒄𝒐𝒔(𝒙) en trait pointillé rouge. 

 

 

Exercice 2 (l’instruction 𝒍𝒐𝒈𝒍𝒐𝒈() ) 

 Create a new script (Ctrl +N). Save with the name : Exercice2_TP7.m 

 Si x et y sont deux vecteurs de même dimension, l’instruction 𝒍𝒐𝒈𝒍𝒐𝒈(𝒙, 𝒚) permet 

d'afficher le vecteur 𝒍𝒐𝒈(𝒙) contre le vecteur 𝑙𝑜𝑔(𝑦). La commande 𝑙𝑜𝑔𝑙𝑜𝑔() s'utilise 

de la même manière que la commande 𝑝𝑙𝑜𝑡(). 

 

 Quelle est la pente de la droite? 

 

Améliorer la lisibilité d'une figure 

Légender une figure 

Pour mettre une légende à une figure : 
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 la commande 𝒙𝒍𝒂𝒃𝒆𝒍 permet d’ajouter un texte en légende sous l'axe des abscisses. 

La syntaxe est : 𝒙𝒍𝒂𝒃𝒆𝒍(′ 𝒍é𝒈𝒆𝒏𝒅𝒆 ′) 

 La commande 𝒚𝒍𝒂𝒃𝒆𝒍 fait de même pour l'axe des ordonnées : 𝒚𝒍𝒂𝒃𝒆𝒍(′ 𝒍é𝒈𝒆𝒏𝒅𝒆 ′) 

 La commande 𝒕𝒊𝒕𝒍𝒆 permet de donner un titre à la figure. La syntaxe est : 

𝒕𝒊𝒕𝒍𝒆(′ 𝒍𝒆 𝒕𝒊𝒕𝒓𝒆′) 

 La commande 𝒈𝒕𝒆𝒙𝒕 permet quant à elle de placer le texte à une position choisie sur 

la figure à l'aide de la souris. La syntaxe est 𝒈𝒕𝒆𝒙𝒕(′ 𝒖𝒏 𝒕𝒆𝒙𝒕𝒆 ′). 

Exercice 3 (Amélioration de la légende d’une figure) 

 Create a new script (Ctrl +N). Save with the name : Exercice3_TP7.m 

 Utiliser les différentes commandes précédentes pour légender une figure. 

 

 

Exercice 4 (Tracer le graphe d'une fonction; la commande 𝒇𝒑𝒍𝒐𝒕()) 

La commande 𝒇𝒑𝒍𝒐𝒕 permet de tracer le graphe d'une fonction sur un intervalle donné.  

Syntaxe :  

𝒇𝒑𝒍𝒐𝒕(′𝒏𝒐𝒎𝒇′, [𝒙𝒎𝒊𝒏 ,  𝒙𝒎𝒂𝒙])  

D’où : 

 𝒏𝒐𝒎𝒇 : soit le nom d'une fonction MATLAB incorporée (cos, sin …), soit une 

expression définissant une fonction de la variable x, soit le nom d'une fonction 

utilisateur. 

 [𝒙𝒎𝒊𝒏 ,  𝒙𝒎𝒂𝒙] : est l'intervalle pour lequel est tracé le graphe de la fonction. 

 

 Create a new script (Ctrl +N). Save with the name : Exercice4_TP7.m 

 1. Illustrons les trois façons d'utiliser la commande 𝒇𝒑𝒍𝒐𝒕. On cherche le graphe de la 

fonction sinus entre  −𝟐𝝅 𝒆𝒕 𝟐𝝅  par l'instruction: 𝒇𝒑𝒍𝒐𝒕(′𝒔𝒊𝒏′, [−𝟐 ∗ 𝒑𝒊 𝟐 ∗ 𝒑𝒊]). 

 2. Pour tracer le graphe de la fonction 𝒉(𝒙) =  𝒙 𝒔𝒊𝒏(𝒙) entre  −𝟐𝝅 𝒆𝒕 𝟐𝝅  , on peut 

définir la fonction utilisateur 𝒉(𝒙) de la manière suivante (attention de bien 

lire x.*sin(x) et non pas x*sin(x)):  

{
𝒇𝒖𝒏𝒄𝒕𝒊𝒐𝒏 𝒚 = 𝒉(𝒙)

𝒚 = 𝒙.∗ 𝒔𝒊𝒏(𝒙);
 

 Chercher alors le graphe de la fonction 𝒉(𝒙) par l'instruction: 𝒇𝒑𝒍𝒐𝒕(′𝒉′, [−𝟐 ∗ 𝒑𝒊 𝟐 ∗

𝒑𝒊]). 
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 3. L'autre façon de procéder est d'exécuter l'instruction :𝒇𝒑𝒍𝒐𝒕(′𝒙 ∗ 𝒔𝒊𝒏(𝒙)′, [−𝟐 ∗

𝒑𝒊 𝟐 ∗ 𝒑𝒊]). 

 

Exercice 5 (Tracer le graphe d'une fonction; la commande 𝒇𝒑𝒍𝒐𝒕()) 

 Create a new script (Ctrl +N). Save with the name : Exercice5_TP7.m 

 Illustrons deux fonctions 𝑓(𝑥) =
𝑠𝑖𝑛(𝑥)

𝑥
  sur [−5;  5] et 𝑔(𝑥) =

𝑐𝑜𝑠(𝑥)

𝑥
  sur [-1; 1]  

utilisons l’instruction 𝒇𝒑𝒍𝒐𝒕(′[𝒇, 𝒈], [−𝟓, 𝟓 , −𝟏, 𝟏]. 

 Légender la figure et utiliser des courbes avec des couleurs différents. 

 

Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 6 de préparation () 

 Create a new script (Ctrl +N). Save with the name : Exercice7_TP7.m 

 Tracez le graphe de la fonction 𝒇(𝒙) = −𝟒𝟖𝒆−𝟏𝟖𝒙 𝐬𝐢𝐧(𝟑𝟏𝟒𝒙 − 𝟏𝟐𝟎) − 𝟒𝟖𝒙 sur [-10; 

10] utilisant ; 

 L’instruction 𝒇𝒑𝒍𝒐𝒕 ; 

 L’instruction 𝒑𝒍𝒐𝒕. 

 Conclure !! 

 

Exercice 7 de préparation (teste d’inversement d’une matrice) 

 Create a new script (Ctrl +N). Save with the name : Exercice7_TP7.m 

 Tracez le graphe de la fonction carré sur [-1; 1] utilisant l’instruction : 𝒑𝒍𝒐𝒕() 

 Tracez le graphe de la fonction carré sur [-1; 1] utilisant l’instruction : 𝒇𝒑𝒍𝒐𝒕() 

 Comparer les deux résultats. 

 

Exercice 8 de préparation (Superposition des courbes dans une même figure) 

 Create a new script (Ctrl +N). Save with the name : Exercice8_TP7.m 

 Tracez les fonctions 𝒇(𝒙) = 𝒆𝒙𝒑(𝒙) sur [-1; 1] ; g(x)=x sur [-1; 1] ; h(x)=log(x) sur 

[1/e; e] sur la même figure. 

 Utiliser les instructions : 𝒇𝒑𝒍𝒐𝒕() 𝒐𝒖 𝒑𝒍𝒐𝒕() 

 Utiliser les deux instructions : 𝒉𝒐𝒍𝒅 𝒐𝒏 𝒆𝒕 𝒉𝒐𝒍𝒅 𝒐𝒇𝒇 
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TP 08 : Utilisation de toolbox 

 

L’objectif de TP : 

Ce TP08 a pour but de vous découvrir les opérations sur les vecteurs et les matrices afin de 

les utiliser pour la résolution des exercices.  

 

Partie 01 : Partie théorique (Toolbox) 

La Toolbox de MATLAB est une collection de fonctions et d'outils spécialement conçus pour 

une application spécifique. Les utilisateurs peuvent utiliser ces fonctions pour effectuer des 

tâches spécifiques sans avoir à écrire leur propre code. Pour utiliser une Toolbox, il suffit de 

l'installer et de l'ajouter à votre environnement de travail de MATLAB. Vous pouvez alors 

accéder aux fonctions de la Toolbox à partir de la ligne de commande ou de l'interface 

utilisateur graphique. Certaines Toolboxes peuvent nécessiter une licence pour être 

utilisées, mais il existe également de nombreuses Toolboxes gratuites disponibles. 

 

La "boîte à outils" dans MATLAB fait référence à un ensemble de fonctions MATLAB 

(également appelées "boîtes à outils") qui fournissent des fonctionnalités supplémentaires 

pour une application ou un domaine d'étude spécifique. Ces boîtes à outils sont distinctes du 

système MATLAB de base, mais peuvent être ajoutées à l'environnement MATLAB selon les 

besoins. 

 

Par exemple, il existe des boîtes à outils disponibles pour les systèmes de contrôle, le 

traitement d'image, l'optimisation, le traitement du signal, les statistiques et de nombreux 

autres domaines. Ces boîtes à outils fournissent un ensemble complet de fonctions et d'outils 

pour résoudre les problèmes et effectuer des tâches dans le domaine respectif. 

 

Une fois qu'une boîte à outils est installée, ses fonctions peuvent être appelées comme 

n'importe quelle autre fonction MATLAB, et ses outils d'interface utilisateur (tels que des 

boîtes de dialogue ou des interfaces utilisateur graphiques) peuvent être utilisés pour 

interagir avec la boîte à outils. 

 



Fiche TP : 08                                               Utilisation de toolbox 

Cours/TP : Informatique 3                - 56 -                   Dr. Ali Abderrazak TADJEDDINE 

 

Control System Toolbox  

Un package pour Matlab composé d'outils spécifiquement développés pour les applications 

de contrôle. Le progiciel propose des structures de données pour décrire des 

représentations de système courantes telles que des modèles d'espace d'état et des fonctions 

de transfert, ainsi que des outils d'analyse et de conception de systèmes de contrôle. Il existe 

également des outils de simulation de systèmes. 

 

Dans cette fiche, vous apprendrez à connaître les commandes de base de Control System 

Toolbox. Lorsque vous aurez terminé cet exercice, vous devriez être en mesure de 

comprendre et d'utiliser Control Systems Toolbox pour créer et analyser des systèmes 

linéaires. Une utilisation intensive de la commande d'aide de Matlab est recommandée. Il est 

également recommandé de créer un fichier de script (par exemple EX01.m) dans lequel vous 

écrivez vos commandes. 

En exécutant un fichier de script au lieu de taper les commandes directement à l'invite 

Matlab, il est plus facile de corriger les erreurs et votre travail sera également enregistré 

pour une utilisation ultérieure. 

 

Exemple 1  

Le système que vous utiliserez est : 

𝑥̇ = 𝐴𝑥 + 𝐵𝑢 = [
0 1

−1 −1
] 𝑥 + [

0
1

] 𝑢 

𝑦 = 𝐶𝑥 = [1 0] 

 

Création et conversion de systèmes 

Control System Toolbox prend en charge plusieurs représentations système de systèmes 

linéaires invariants dans le temps. Dans cet exercice, nous utiliserons deux des 

représentations les plus courantes ; modèles d'espace d'états et fonctions de transfert. 

 

Définissez les matrices du système A, B, C et D données ci-dessus. (Quelle est la valeur de D 

dans le modèle ?) Créez une description de l'espace d'état du système à l'aide de ss et 

nommez-la sys_ss. Découvrez comment utiliser ss en utilisant la fonction d'aide (help ss). A 

ce stade, vous devriez avoir obtenu une description de l'espace d'état du système. 

Créons maintenant un modèle de fonction de transfert équivalent du système ci-dessus. 

 

Cela pourrait, comme vous le savez, être fait en utilisant la formule : 

𝐺(𝑠)  =  𝐶(𝑠𝐼 −  𝐴)−1 𝐵 +  𝐷 
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Cependant, Matlab peut également être utilisé pour la tâche. Utilisez la commande tf pour 

convertir le modèle d'espace d'états en une fonction de transfert et nommez-le sys_tf. Notez 

que tf peut être utilisé pour la création de fonctions de transfert ainsi que pour la conversion.  

 

Quelle est la syntaxe dans les deux cas respectivement ? 

 

Exemple 2 (Analyse de stabilité) 

La stabilité d'un système linéaire est déterminée par l'emplacement de ses pôles dans le plan 

complexe.  

Quelle est la condition de stabilité ? 

Utilisez les commandes ssdata et tfdata pour extraire les données nécessaires des modèles, 

et eig et roots pour déterminer la stabilité du système. Vérifiez que les racines du polynôme 

caractéristique de la fonction de transfert sont les mêmes que les valeurs propres de la 

matrice du système.  

Quelles sont les valeurs propres / pôles ? 

Le système est-il stable ?  

Vous pouvez également utiliser le pôle de commande, ou pour une vue graphique, pzmap. 

 

Exemple 3 (Analyse du domaine temporel) 

Utilisez la commande step pour tracer la réponse indicielle du système. Reliez les 

caractéristiques de la réponse indicielle à l'emplacement des pôles. Si vous avez le temps, 

utilisez initial et lsim pour étudier la réponse du système. 

 

Tous les blocs nécessaires pour ce modèle 
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Quelques commandes Matlab utiles 
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Présentation de Simulink 

L’instruction Simulink donne un programme de simulation basé sur Matlab nommé 

Simulink. Il existe plusieurs façons de définir un modèle. On peut travailler graphiquement 

et connecter des blocs-diagrammes avec des blocs prédéfinis. Alternativement, on peut 

donner la description mathématique sous forme d'équations différentielles dans un fichier 

m (le format des programmes écrits dans le langage de programmation Matlab). 

Matlab/Simulink prend en charge ces deux représentations ainsi que les combinaisons. De 

plus, on peut utiliser des descriptions qui incluent une hiérarchie de sous-systèmes 

connectés. 

 

 

 

Pour comprendre comment les modèles sont décrits et simulés à l'aide de schémas 

fonctionnels, il est préférable d'exécuter de petits exemples sur un ordinateur. Le reste de la 

section 2 montre quelques exemples. Si vous connaissez Simulink, vous pouvez passer 

directement à la section 3. 

 

Comment démarrer Simulink 

Donnez la commande simulink dans Matlab (command window). Cela donne une fenêtre 

avec des blocs comme dans la figure ci-après. 

 

 



Fiche TP : 08                                               Utilisation de toolbox 

Cours/TP : Informatique 3                - 60 -                   Dr. Ali Abderrazak TADJEDDINE 

 

Un système simple 

 Cliquez sur Fichier dans la fenêtre Simulink et choisissez Nouveau->Modèle.  

 Cliquez sur le bloc Continu et déplacez un Transfert Fcn vers la nouvelle fenêtre 

appelée « untitled ».  

 Faites de même avec Source->Step Fcn et Sinks->Scope.  

 Dessinez des flèches (bouton gauche de la souris) et connectez les ports sur le bloc.  

 Vous devriez maintenant avoir un schéma fonctionnel comme dans la figure ci-après. 

 

 

 Choisissez Simulation->Paramètres dans la fenêtre intitulée " untitled ".  

 Réglez l'heure d'arrêt sur 5. Ouvrez la fenêtre Portée en double-cliquant dessus.  

 Mettez la plage horizontale à 6.  

 Lancez une simulation par Simulation->Démarrer (ou en appuyant sur Ctrl-t dans la 

fenêtre intitulée "Sans titre"). 

 

Exemple 4 (changer un système) 

Pour changer le système en : 

7

𝑠2 + 0.5𝑠 + 2
 

 

Double clic sur Transfert Fcn 

 

 



Fiche TP : 08                                               Utilisation de toolbox 

Cours/TP : Informatique 3                - 61 -                   Dr. Ali Abderrazak TADJEDDINE 

 

 Vous devriez maintenant avoir un schéma fonctionnel comme dans la figure ci-après. 

 

 

Le système devient : 

 

Comment changer un signal d'entrée Pour changer le signal d'entrée, commencez par 

supprimer le bloc Step Fcn en cliquant dessus et supprimez-le en utilisant Edit->Cut (ou en 

appuyant sur Ctrl-x). Remplacez-le par un bloc Sources->Signal Gen. Double-cliquez sur 

Signal Gen et sélectionnez le signal, l'amplitude et la fréquence. Modifiez également 

Simulation->Démarrer->Temps d'arrêt sur 99999 et appuyez sur Simulation->Démarrer. 

Cela donne une simulation "infinie" qui peut être arrêtée en appuyant sur Simulation->Stop 

(ou Ctrl-t). 

L'amplitude du signal d'entrée peut-elle être modifiée pendant la simulation ? Essayez 

également de changer le bloc Transfert Fcn pendant la simulation. 

Comment utiliser les variables Matlab dans les blocs Notez que les variables définies dans 

l'environnement Matlab peuvent être utilisées dans Simulink. Définissez le numérateur et le 

dénominateur en écrivant ce qui suit dans la fenêtre Matlab. 
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nombre=[7 6] 

repaire=[1 2 3 4] 

Remplacez Transfer Fcn->Numerator par num et Transfer Fcn->Denominator par den. 

 

Comment enregistrer les résultats dans les variables Matlab Pour enregistrer l'entrée et la 

sortie, déplacez deux copies du bloc Sinks->To Workspace. Assurez-vous que l'option 

"enregistrer le format" est définie sur "Array", voir figure 2. Connectez-les avec l'entrée et la 

sortie au bloc Transfer Fcn. Obtenez également une Source-> Clock et connectez-la à un 

Sinks-> To Workspace. Remplacez les noms de variables par u, y, t respectivement. La fenêtre 

doit ressembler à la figure. 
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 Comment utiliser les résultats de la simulation dans les calculs Matlab Supposons que 

le signal d'entrée soit sinusoïdal avec une fréquence de 0,1 rad/s et une amplitude de 

 Effectuez une simulation suffisamment longue pour que la sortie devienne 

stationnaire.  

 Calculez la valeur maximale de y lorsque le système s'est stabilisé. 

n=longueur(y) 

max(y(n/2:n)) 
 

Utilisation des modèles Simulink dans les scripts Matlab 

Souvent, il est pratique de travailler avec des scripts Matlab (fichiers m), afin de sauvegarder 

une séquence de commandes. Il est possible d'utiliser des modèles Simulink depuis un script 

Matlab, en utilisant la commande sim. En utilisant la commande simset, les options de la 

commande sim peuvent être spécifiées. 

 

Utilisez le modèle de l'exemple précédent. Enregistrez le modèle et nommez-le 

"mymodel.mdl". Créez un script Matlab nommé "mysim.m", et saisissez les commandes 

suivantes : 

 

1. tfinal = 300;  

2. options = simset(’reltol’,1e-5,’refine’,10,’solver’,’ode45’);  

3. sim(’mymodel’,tfinal,options); 

 

%plot results 

4. figure(1) 

5. clf 

6. subplot(211) 

7. plot(t,u); 

8. ylabel(’u’) 

9. subplot(212) 

10. plot(t,y) 

11. ylabel(’y’) 
 

Lorsque vous exécutez le script, vous devriez voir un tracé montrant l'entrée et la sortie de 

la fonction de transfert. Utilisez la commande help pour en savoir plus sur l'utilisation des 

commandes simset et sim. 

Comment enregistrer des systèmes Utilisez Fichier-Enregistrer sous ou Fichier-

>Enregistrer. 
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Partie 02 : Partie Simulation (Un système de flux) 

Considérez un réservoir simple comme dans le cours de contrôle de base 

ℎ̇ =
1

𝐴
(𝑢 − 𝑞) 

𝑞 = 𝑎√2𝑔ℎ 

Cela peut être implémenté dans Simulink comme dans la figure ci-après. La fonction f (u) a 

la valeur 𝑎 ∗ 𝑠𝑞𝑟𝑡(2 ∗ 𝑔) ∗ 𝑠𝑞𝑟𝑡(𝑢[1]). Le bloc Sum a reçu deux entrées avec des signes 

différents en attribuant la chaîne "-+|" à Somme->Liste des signes. Les blocs d'entrée et de 

sortie se trouvent respectivement sous les sources et les puits. 

 

Ces blocs indiquent à Simulink ce qui doit être considéré comme des entrées et des sorties 

vers ce sous-système. Les titres des blocs peuvent être modifiés en cliquant dessus. Marquez 

l'ensemble du système en maintenant le bouton gauche de la souris enfoncé et en dessinant 

un carré autour. Ensuite, choisissez Edition->Créer un sous-système. Le résultat est que le 

système est représenté par un bloc. Utilisez Édition->Copier pour créer le système à double 

réservoir suivant. 

 

Exercice 1 

Utilisez la commande linmod pour trouver un modèle linéarisé du double réservoir autour 

de ℎ1
0

=  ℎ2
0 =  0.1. Utilisez les paramètres 𝐴1  =  𝐴2  =  2.7  10−3, 𝑎1 =  𝑎2 = 7 × 10−6, 𝑔 =

 9.8. Remarquez également dans la figure le bloc Simulink à partir des sources et le bloc 

Simulink à partir des puits, qui sont nécessaires pour le commande linmod. 
 

>> A=2.7e-3; a=7e-6; g=9.8; 

 

 

>>x0 = [0.1000 0.1000]’; 

>>u0 = a*sqrt(q*g*x0(1)); 

>> [aa, bb,cc,dd]=linmod(’flow’,x0,u0); 
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Partie 03 : Partie expérimentale (MATLAB – SIMULINK) 

Exercice 6  

Construisez un modèle Simulink pour calculer les valeurs de la fonction cosinus g(t) = cos 

(ωt) pour t = 0…3 avec 3 000 pas incrémentiels et ω = [π, 2π, 3π, 5π, 7π] spécifié dans 

MATLAB. Simulez votre modèle Simulink à l'aide de MATLAB avec la commande sim() en 

utilisant une boucle [for ... end] ou [while .. end] pour toutes les valeurs de ω. 

 

Exercice 7  

L'accélération d'un parachutiste est déterminée par : 

𝑎 = 𝑔(1 −
𝑣2

3600
) 

 

D’où: g = 9,81 m/sec2. 

Créez un modèle Simulink pour simuler l'accélération d'un parachutiste. 

 

Exercice 8  

L’introduction de fonctions de transfert s’effectue sous plusieurs formes polynomiales, 

forme ZPK (zéros, pôles, gain), forme d’état. Prenons quelques types de systèmes asservis, 

deuxième et troisième ordre pour s’entrainer sur la déclaration de ces systèmes. 

𝑓1(𝑠) =
𝑠 + 5

𝑠3 + 8𝑠2 + 17𝑠 + 10
; 𝑓2(𝑠) =

𝑠 + 10

2𝑠2 + 3𝑠 + 1
 

𝑓3(𝑠) = 4.25
(𝑠 − 2)(𝑠 + 1.2)

(𝑠 + 0.3)(𝑠 + 1)(𝑠 + 5)
 

1. Consulter l’aide en ligne sur les commandes Tf, ZPK, TF2SS, TF2ZP 

2. Créer un fichier de commande tp3ex1.m pour les commandes MATLAB de l’exercice 

N°1 

3. Introduire 𝐟𝟏(𝐬) et 𝐟𝟐(𝐬) sous MATLAB 

4. Donner les pôles de ces deux systèmes 

5. Introduire le système 𝐟ଷ(𝐬) en utilisant la commande ZPK 

6. Passer de la représentation fonction de transfert de 𝐟𝟏(𝐬) et 𝐟𝟐(𝐬) vers la forme ZPK 

connue par la forme d’Evans 𝐇(𝐬) = 𝐊 (𝐬-𝐙(𝟏))(𝐬-𝐙(𝟐))...(𝐬-𝐙(𝐧)) (𝐬-𝐏(𝟏))(𝐬-

𝐏(𝟐))...(𝐬-𝐏(𝐧))). 

7. Passer de la représentation fonction de transfert de fଵ(s) et fଶ(s) vers la forme d’état 

Ẋ = AX + Bu, y = CX + Du. 

8. Passer de la représentation ZPK de fଷ(s) vers la forme Ẋ = AX + Bu, y = CX + Du. 

9. Enregistrer l’espace de travail de cet exercice dans tp3ex1.mat 
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Exercice 9 (Construction de Schémas Fonctionnels) 

Soit le schéma fonctionnel donné par la figure ci-dessous 

 
 
 

1. Consulter l’aide en ligne sur les commandes Series, Parallel, feedback 

2. Créer un fichier de commande tp3ex2.m pour les commandes MATLAB de 

l’exercice N°2 

3. Donner la fonction de transfert en boucle ouverte 

4. Donner la fonction de transfert en boucle fermée (Y(s)/U(s)) 

5. Vérifier le résultat analytiquement. 

6. Calculer les pôles de la fonction de transfert en boucle fermée 

7. Passer de cette fonction de transfert aux différentes formes (ZPK, SS ) du système 

en BF 

8. Enregistrer l’espace de travail de cet exercice dans tp3ex2.mat 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Références Bibliographiques  
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Références Bibliographiques                               Cours : Electrotechnique fondamentale 1 
 

Cours : Electrotechnique fondamentale 1         - 68 -     Dr. Ali Abderrazak TADJEDDINE 

 

 

Références Bibliographiques 
Cours / TP : Informatique 3 

 

 
 
Selon la disponibilité de la documentation au niveau de l'établissement, Sites internet...etc.) 

1. SCILAB : 
1.1. Informatique: Programmation et simulation en Scilab 2014 - Auteurs : Arnaud 

Bégyn, Jean-Pierre 
Grenier, Hervé Gras.  

1.2. Scilab : De la théorie à la pratique - I. Les fondamentaux. Livre de Philippe Roux 
2013. 

 
2. MATLAB :  

2.1. Références Françaises : 
- Introduction à MATLAB et SIMULINK, Un guide pour les élèves de l’École Nationale 
Supérieure   d’Ingénieurs Electriciens de Grenoble, Paolino Tona. 
- C++ pour les nuls, Stephen Randy Davis. 
 

2.2. Références Arabiques : 
، المهندس عدنان شاهينالماتلاب للمهندسين  

 

2.3. Références Anglaises:  
- Essential MATLAB for Engineers and Scientists, Seventh Edition, Brian D. Hahn 

& Daniel T. Valentine. 
- Numerical Analysis Using MATLAB and Excel, Steven T. Karris.  
- Matlab for Dummies, Jim Sizemore, John Paul Mueller. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Références Bibliographiques                               Cours : Electrotechnique fondamentale 1 
 

Cours : Electrotechnique fondamentale 1         - 69 -     Dr. Ali Abderrazak TADJEDDINE 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fin 
Cours / TP : Informatique 3 


